Creating Intelligent Details and Keynotes in AutoCAD Architecture

Sridhar Subramani
Senior Product Owner
Autodesk, Inc.

Learning Objectives

- Learn how to create the detail components
- Learn how to modify the detail components
- Learn how to create the keynote on detail components
- Learn how to place detail files on a sheet

Description

Everyone knows that AutoCAD Architecture is a 3D program, and that it has intelligence when modeling. However, this intelligence is sometimes lost when creating details. In this session, we’ll show how to create intelligent details using detail components. In doing this, we’ll be able to keynote these elements to maintain a consistent noting procedure. We will then introduce how to modify the detail components. We will also learn how to place all of the detail files on a sheet. If keynoting isn’t your choice, we’ll also cover how to tag these elements so that there’s consistent notation of the details on every project.

Your AU Expert:

Sridhar Subramani has more than 20 years of CAD experience, working as Senior Product Owner at Autodesk, Inc. A frequent presenter at AutoCAD University for the last 7 years. A seasoned professional in software testing, he has also been actively involved in news groups of AutoCAD Mechanical software and AutoCAD Architecture software and resolved over 1500 issues reported by customers. Sridhar conducts in-house training in AutoCAD software and AutoCAD Architecture software. He has written several technical solutions that are published on the Autodesk support website.
Table of Contents

AS462110 ......................................................................................................................... 1
Creating Intelligent Details and Keynotes in AutoCAD Architecture .............................. 1
1. Introduction to Detail Components: ................................................................. 3
2. Create Detail Components ............................................................................. 3
   2.1 Using Detail component manager .......................................................... 3
   2.2 Using Tool Palette ....................................................................................... 5
3. Modify Detail Components ............................................................................... 6
4. Create Keynotes ................................................................................................. 7
5. Annotate detail components ........................................................................... 8
6. Detail view on Sheets ......................................................................................... 8
1. Introduction to Detail Components:

Using the Detail Component Manager dialog box, you can navigate among different detail component databases. A hierarchical tree view and a filter feature make it easy to locate individual components within a database. Once you find the component you need, you can insert it into a drawing, or you can drag and drop it onto a tool palette for repeated use. Note that the five buttons arranged vertically in the middle of the dialog box are unavailable unless you have edit privileges for the selected database.

Most of the components that you will need to create your 2D enlarged details in AutoCAD Architecture are available in the Detail Component Manager. Detail Components represent specific materials or elements in a building. They can be blocks, hatches or single entities.

2. Create Detail Components

2.1 Using Detail component manager

Figure-1

Let us create an architectural detail using the Detail Components Manager.

1. Launch AutoCAD Architecture 2021 or MEP 2021 using the Imperial profile
2. Open new drawing based on Aec Model (Imperial Stb).dwt template
3. On the Status bar, lets choose the current Annotation Scale as 3/4"=1'-0".
4. From the Home tab, pick the Detail Components tool to open the Detail Component Manager dialog box.
5. Select Division 04 - Masonry, then expand Concrete Unit Masonry, and click 2 Core CMU. From the list at the bottom, select the 8" x 8" x 16" CMU component, then click the Insert Component button.
6. In the Properties palette, Component group is the View option. Click it, and notice that there are four different view directions for placing this component. Let us use the Section option. Under Specifications, there are Hatch options for the CMU, Cores, and Mortar. The Mortar category lists the Type of Mortar for Keynote annotation, and the types of joints are listed. Select Yes for Hatch CMU, Show mortar, and Hatch Mortar
7. At the Start point prompt, the down-arrow lists options X- or Y flip, or Count. Click Yflip, the component flips over vertically.
8. Pick a point anywhere in the drawing, and then drag the cursor up, and the routine adds as many courses as will fit from the first to the second pick point.
9. Place five courses, right-click and select Enter to end the command.
10. From the Home tab, Detail group, pick the Detail Components tool. In the Detail Component Manager, Expand Division 05 - Metals, then Steel Joist Framing, then the H-Series Open Web joists. From the components list at the bottom, select the 12H3 Steel Joist, then pick Insert Component.
11. Again, it is important to choose a View option in the Properties palette. Select \textbf{Elevation} view type. At the Start point prompt, pick where the joist will begin to bear on the wall on the upper-right corner (Figure-2 P1). At the End point prompt, drag to the right to create a portion of the joist (P2). At the Bearing length prompt, choose how long the bearing length of the joist will be. Pick the top left block corner (P3), right-click, and click Enter to end the command.

12. Let us add some Concrete filled Metal Decking. Re-open Detail Component Manager and expand Division 03 - Concrete, then Structural Concrete. Select Slab with Metal Decking. From the bottom list, click 3" Concrete Slab, then Insert Component.

13. In the Properties palette, the View direction will be Section. In the Specifications group, Hatch Slab is Yes, and Show reinforcing is No. For the Deck Type, accept the defaults, then pick at the top left end of the joist ((Figure-3 P1) and the right end of the joist (P2), right-click, and click Enter to end the command.

14. Command COPY, select the five CMU’s and press enter key, pick the far-left edge of the bottom mortar joint (P1), then pick the top left corner of the slab (P2), then press Enter. Save the drawing and keep it open for the next exercise.
2.2 Using Tool Palette

Another way to access Detail Components is from the Tool Palettes, Detailing group. There are six palettes available, including Basic, Exterior, Roofing, Doors & Windows, Interiors, and Finishes.

2. In the Properties palette, View options, select Section. The Setting position option has a list of directions for setting the brick. Select Stretcher. Hatch Brick, Mortar, and Show mortar are all set to Yes.
3. At the Start point prompt, pick Yflip. Using Object Snap Tracking, hover over the bottom-left CMU mortar corner, then drag to the left and type in 1". drag up until you get to the top of the wall, use Object Snap Tracking to align with the top CMU corner, pick, then press Enter to end the command.
4. Save the drawing.
3. Modify Detail Components

After creating 2D Details in AutoCAD Architecture, you may need to modify them. Let us review some different methods to do this.

**Figure-7**

The first method to modify is using a normal AutoCAD edit.

1. Open the drawing saved in the previous exercise or sample.dwg drawing.
2. Hover the cursor over the Concrete and Metal Deck slab, and notice that it is listed as a Detail Component. However, when you select it, in the Properties palette, Design group, we see that it is listed as a Block Reference.
3. To edit the Block, right-click, and from the pop-up menu, select Edit Block in-place, which opens the Reference Edit dialog box. With the Anonymous block selected, under Reference name, click OK.
4. A new group called Edit Reference is added at the right on the Ribbon, with four options. We want the Concrete hatching twice as dense.
5. Selecting the Hatch (green arrow in figure 7) adds the Hatch Editor tab to the Ribbon. Here, in the Properties panel, the Hatch Pattern Scale is currently 1". Type in 0.5 in the Properties panel Scale box and press Enter, then the Esc key, to return to the previous tab.
6. To save this change, from the Edit Reference panel, select the Save Changes tool, and click OK in the warning dialog box.

The second method to modify detail component is using “Replace selected”

7. Next, we want to change one of the CMU components. We want the block under the Steel Joist to be a bond beam instead of a 2 Core CMU. (Red circle in Figure 7)
8. Select it, right-click, and from the pop-up menu, click Replace Selected. The CMU is attached to the cursor, and ready to be moved.
9. In the Properties palette, Component group, select the Type option, and choose Bond Beams. From Description, click the Single 8" x 8" option. Pick at the upper-left corner of the top CMU, right-click, and click Enter To end the command.

The third method to modify the detail component is using “AEC modify Tools”

![Figure-8](image)

10. Select the Bond Beam and CMU components below the Steel Joist and move them up from the top of the Bond Beam to the top edge of the Steel Joist. The Steel Joist is going to be notched into the Bond Beam, and we want the portion inside the Bond Beam component to use hidden lines.

11. Select the Steel Joist and right-click. In the pop-up menu, AEC Modify Tools cascading menu, select the Obscure option. At the prompt, "Select obscuring object(s) or NONE to pick rectangle", select the Bond Beam, then press Enter. The bearing portion of the Steel Joist inside the Bond Beam is changed to the layer A-Detl-Hide, whose Color is Red and Linestyle is Hidden2 in this file.

![Figure-9](image)

12. Another AEC Modify option is Subtract. Draw a circle as shown in figure 9, partially through some of the Bricks in the exterior wythe.

13. Select the Brick Detail Components that the circle passes through and right-click. From the pop-up menu, AEC Modify Tools menu, select the Subtract option. At the "Select object(s) to subtract" prompt, pick the circle, and press Enter. At the "Erase selected linework" prompt, click Yes to delete the circle. We have subtracted the circle from the Bricks.

4. Create Keynotes

Annotating Architectural details that you create using Detail Components is accomplished with either Reference or Sheet Keynotes. The CSI Division and Keynote text that will be used from the Keynote Database is specified in the Detail Component Manager. Select the 3" Concrete Slab Detail Component, and on the Properties palette, Extended Data tab, Dimensions group, the Keynote is listed. This will be used when Keynoting the component.

1. Continue the same drawing used in the previous example or open sample drawing attached with the data set.
2. On the Annotate tab, Keynoting panel, pick the Reference Keynote (Straight) tool.
3. At the prompt, "Select object to keynote or Enter to select keynote manually", pick the Concrete Slab component. At the prompt, "Select first point of leader" again pick on the Slab. At the prompt, "Specify next point of leader line", pick up and to the right. At the "Select text width <0>" prompt, pick further to the right, and the Keynote is placed. The information in the Keynote comes from the Database file associated with the Detail Component.
4. Place another Reference Keynote, then pick a CMU Detail Component, pick a point for the leader start and end, then for the text width.
5. So, it is very easy to annotate your Detail Components using Reference Keynotes, because the required information comes from the Keynote Database file associated with the Detail Components.

To update the Keynotes to not include the CSI number, or to only include the CSI number, from the Annotate tab, Keynoting panel title drop-down list, select the Reference Keynote Display tool, which opens the Select Reference Keynote Display dialog box. In the middle group, Field names, choose the radio button for the option you want, then click OK. The Keynotes will be updated to reflect your choice.

5. Annotate detail components

1. Continue the same drawing used in the previous example or open sample drawing attached with the data set.
2. On the Annotate tab, Keynoting panel, pick the Text (Straight Leader) tool
3. At the prompt, “Specify first point of leader line:" pick a point on detail component (Steel Joist), at the prompt, “Specify next point of leader line” press enter key, at “Select text width <0>”: press enter key, at the prompt, “Enter first line of text <Mtext>:” type the text “Steel Joist”. The annotations are created on the same layer as keynote annotations.

6. Detail view on Sheets

To place a detail view on a sheet with automatic update of sheet numbers, title marks, we need to be in the project environment. The callout tags are automatically updated in the view drawing as well as the sheet drawing. When there is a change in the view drawing, the sheet drawing is also updated.

1. Open AU2020 project through Project Browser. (command projectbrowser)
2. In the Project Navigator, switch to Constructs Tab and double click on the detail_view_from_callout to open the drawing file.
3. In the Tool Palette, switch to Design Group and then Callouts Tab.
4. Zoom in on the ‘column number 2’ as shown in figure-10
5. From the Tool Palettes>>Callouts palette, pick the Detail Boundary B tool.
6. At the Specify one corner of detail box prompt, pick a point above and to the left of the column. At the Specify opposite corner of detail box prompt, pick a point above and to the right of the column. The callout boundary is created.
7. At the Specify first point of leader line on boundary prompt, pick a point diagonally down from the lower right of the callout boundary. At the Specify next point of leader line, end line< end line> prompt pick a point to the right, then press ENTER.
8. In the Place Callout Dialog Box name the view "Detail of column number 2".
9. Leave all the defaults like the Generate Section/Elevation and Place Titlemark check boxes.
10. Make sure the Scale is 1/2”=1'-0”.
11. Click the New View Drawing button.
12. In the “Add detail view” dialog box, enter the name as "Detail of column number 2", Select the Level 1 Division and click Finish in the next dialog box. Press enter key when project to “Specify elevation for plan section <3'-6”>,” and “Specify depth of plan section <8'-0”>,” and pick a point above the detail to insert the detail view on prompt “Specify insertion point for the 2D section result”.
13. Save the drawing file.
14. In the Project Navigator, switch to the View Tab, double click the "Detail of column number 2" detail view to open and exactly zoom to the detail component. See figure 11 below.

![Figure 11](image)

15. In the Project Navigator, switch to the Sheets Tab, Details folder, open “101 Detail at Column number 2” drawing
16. In the Project Navigator, switch to the Views Tab, drag and drop "Detail of column number 2" detail view in the sheet and accept the annotation scale.
17. The Sheet number is updated. Open the "Detail of column number 2" from the Views Tab to see the sheet number updated. Open the " detail_view_from_callout" from the Constructs Tab to see the sheet number updated.

Refer video link for the steps to create “Detail view on Sheets” [https://autode.sk/3k7xFWh](https://autode.sk/3k7xFWh)